
PROJECT complete
Marking software



2 Phoenix Contact USA, Inc.

About PROJECT complete
PROJECT complete is a direct replacement for CLIP PROJECT and offers a new look and new 
features. The software is free and can be downloaded and registered at:  
www.phoenixcontact.com/project-complete
This guide will help step you through the features of creating and printing marking files.

Operating system: MS Windows 7 (32/64-bit), MS Windows 8 (32/64-bit), MS Windows 8.1 
(32/64-bit), MS Windows 10 (32/64-bit) 
For assistance with any topic in this guide, please contact our technical service department:  
800-322-3225: Monday-Thursday 8 am-8 pm EST, Friday 9:30 am-5 pm EST

New features of PROJECT complete marking

 ✓ The template build is now included to create custom 
templates

 ✓ Speed marking for rail assembly

 ✓ Easier visual layout

 ✓ Search for materials by type or part number
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ContentsCreating and printing a marking file

Getting started
Click the PROJECT complete marking icon  
to open the software.

Allow a moment for the program to load.



Special characters

Text editing tab

Inputting data

Inserting new material
The initial starting page will display the ability to create a  
new marking project

Click the Home tab (the marker  
must be highlighted before  
changing the font)

Text rotation

Set font alignment

Set font size if needed

Choose a font type. Arial is the 
default

Click Special characters

Click on View

Using the Insertion Center (if Insertion Center is not 
active, go to View and click the insertion center icon) 
navigation panel, select your printer

Using the material list associated with your printer, 
select your desired marker
Double-click to insert the marker file on the screen

Search for the material by entering the part number or 
type description, or scroll through the list

Click on the marker to enter data

To enter multiple lines of text on 
a marker, hold Alt + Enter or use 
the down arrow on the keypad

By hitting Enter or Tab, you will 
be moved to the next row of 
markers
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Automatic sequencing

Working area: automatic sequencing

Working area: special characters

Choose symbols from categories by selecting the tab along the top of  
the window

The drop-down menu opens up other choices under System fonts only. All  
others have just one type

Select the desired symbol

Click insert, double-click, or drag and drop onto the marker

Click View

Click on Label numbering

Label numbering

Choose between numbers or letters

Select the start value, end value, and increment

Enter any alphanumeric prefixes if needed

Click Start
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Label numbering sample

Examples

Font style and size

Text rotation

Symbol

Enumeration with the prefix A- 
and postfix -T3
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Using the  
Auto Fill function
This fills the remaining markers with  
the same content

Using the Automatic  
wire marking function
Create 360° visibility ideal for wire 
marking

Only available for labels with  
multiple rows of markers

Enter data into the first marker

Right-click on the first marker and 
select Fill

The remaining markers are filled  
with that data

Enter the data on the wire marker
Make sure the marker is selected 
as indicated by the green highlight

Select Cable wrap under the  
Home tab

Data is then automatically repeated 
in as many rows possible to ensure 
visibility in all directions. 
(Font must be small enough for 
multiple rows)
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Setting the length of  
endless material
The unit of measure is metric by  
default, you can change this in Options

Print

Select an endless material  
(designated with an “E” in the  
parentheses)

Right-click on the marker and under  
“Set material length,” type in the 
desired length. Hit enter to apply

Click to Print

Click Print in print manager
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PROJECT complete wire marking features: Set relation
Set the relation from the label to the wire.

1. Open your marking file or create a 
new file.

2. Navigate to the Wire Marking tab 
in the menu bar.

3. Select the first marker in your file 
so it is highlighted green.

The Set Relation feature allows you to set the relation from the label to the wire to organize individual 
markers or multiple markers in a file, providing easy organization of markers to wires. 

4. Click the Set button located in the 
Relation section of Wire  
Marking. This will automatically set 
the marker relation to wire #1.

5. Selecting the next marker and 
clicking Set will set the relation to 
wire #2. This process will set the 
relation to the next number in the 
sequence to mark each wire.

6. To set a relation for multiple 
markers at a time, select multiple 
markers and click Set.
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PROJECT complete wire marking features: Set relation

7. This will open a dialogue window 
where you can further define  
custom wire relations to each 
marker in the file. This window 
will only become available if you 
have multiple markers selected 
before clicking Set. Note: In the 
Define Wire Relations window, 
you can set the wire relation to 
designate all markers for one wire. 
Additionally, you can set one  
label per wire as well as customize 
the number of labels that will go 
on each wire. Click Apply to set 
relation

PROJECT complete wire marking features: Wire wrap feature
Use the wire wrap feature to repeat markers to fill a single marker easily.

1. Open a blank marker file and 
add one single line of text to the 
marking area

2. Set the number of repetitions 
needed and click Apply. 

 Note: The marker will only fill 
the number of repetitions that 
will properly fit the marker. Click 
Auto Size to automatically set the 
marking to fit the marking area
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PROJECT complete wire marking features: Duplication
Automatically set the quantity of markers needed.

1. Select a marked marker to  
highlight it in green. This will  
enable the duplication option in 
the wire marking tab of the  
PROJECT complete menu

2. Using the duplication quantity 
field, set the number of  
duplications needed for the  
selected marker. Click Apply.

3. The marker file will show the 
set number of duplicates for the 
selected marker

PROJECT complete marking: Basic wire switch feature
The PROJECT complete marking switch feature allows you to automatically reverse the wire source and 
target to create a matching file for each end of the wire connection.

1. Create a file with at least two wire 
marking sets

2. Using the text tool, mark the first 
label with the wire source (A1) and 
the wire target (B2), separated by 
a colon
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PROJECT complete marking: Basic wire switch feature

3. Select the first label with your 
cursor and highlight Wire  
Marking in the tool bar

4. Click Settings

5. In the Switch settings window, 
specify the switch indicator by 
highlighting it with your cursor.  
In this case, it is the colon. The 
switch indicator can be any other 
character if the character is  
specified as the switch indicator. 
Click Save. Example: A1/B2, A1-
B2, etc.

Additional options: If working with 
multiple labels, you can specify the 
change for the current or next label. 
You can also choose to remove or 
switch the indicator in the second 
dropdown menu.
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PROJECT complete marking: Basic wire switch feature

6. Using your cursor, drag to select 
the wire marker(s) needed to 
apply the switch.

7. Click Apply in the tool bar to  
apply the switch of the wire 
source and target.
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Importing data from  
Excel
Data can be created in Microsoft  
Excel (or another source) and  
imported into PROJECT complete.  
This requires an initial configuration  
of the Transfer Setting Manager

It is important to input the data 
into a single column of Excel. 
File must be saved and closed to 
import.

Excel import continued

Click File

Click Data Exchange
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Excel import continued

Click New

Click the Browse button to find the 
Excel file
(You may have to change to All 
files to find the Excel file)

Click Open

Excel import continued

Preview the data
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Excel import continued

Click Material mapping

Click Enforce default material. 
The insertion center will  
automatically pop up

Select your printer

Select the desired material

Click Insert

Excel import continued

Click Run Import

The file has been imported and 
you will be returned to the  
standard view

You may make any changes as  
needed and print the project
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Inserting graphics
PROJECT complete supports any image  
file (.ipg, .tif, .gif, .bmp, etc.). Pure black  
and white is recommended for best print  
quality (unless using the Bluemark ID  
color printer).

Select the desired material and  
click Insert at top. Click on material

Use the yellow “grab points” for 
resizing the graphic

Draw a box for estimated size of 
graphic

In the pop-up window, browse to 
select graphic

Click Bitmap
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Re-sizing and  
positioning graphics for  
specific requirements
A grid helps visually lay out the  
graphic on the label

Click in marker area to use the 
visual grid and snap-to grid 
(graphic must be highlighted for 
this menu to be visible)

Click layout and input specific  
dimensions for width and height

To change the width and height 
independently, click the chain 
icon to break

The Frame option outlines the 
graphic. Adjust the line thickness 
and choose line type from the 
dropdown

Toggle the visual grid and snap-
to grid on or off, depending on 
your preference

Visual grid and snap-to grid 
turned on

Need to be in View
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Inserting barcodes

Change material wizard
This wizard is helpful for changing the  
material type of an existing project

Click insert and select barcode

Click to highlight the marker

Use dropdown to choose  
barcode type

Use the mouse to draw a box 
where you want the barcode

Type in the white area and hit enter

Use the yellow “grab points” to 
resize the barcode if needed

Click the Home tab

Then click Select material

Click Change material
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Changing material  
continued
You can change the material to any  
type regardless of material type or  
printer

Starting a new template
PROJECT complete offers the  
template creation that is used to  
design custom labels on existing  
materials

Choose material and click Insert

Click Ok

Click File

Choose printer and material

Click New and New template
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Template build continued
Inserting text fields
Input field: blank text field where  
data can be entered
Permanent field: text field with  
present information which cannot be  
altered, preventing changes to the  
custom template

Template build continued

Represents a permanent field

Represents an input field

Highlight template

Draw a box the estimated size of  
the text field (can be adjusted later)

Click Insert and select Text field

Click the View tab and choose 
the snap-to grid and Use grid
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Template build continued

Click the area to be protected

Click Content Protection and  
Location Protection
This locks the graphics and text 
fields so they cannot be changed

For indexing through text fields, 
you need to click on Properties 
to access the text field name and 
number

Indexing example, 1, 2, 3

Template build continued
Saving the created template

Click File, then click Save as

Name the template and click 
Save

Click in the Text field and give it 
a name (optional), hit Enter. Give 
it a number in the Index box and 
select the checkmark
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Template build continued
Exporting the template allows you to  
save the template outside of the  
PROJECT complete library, for saving  
to other computers

Click file Templates, Export  
template

Select the template to be  
exported

Click Export template and save 
file in desired location

Select the template to be  
exported and click Export

Template build continued
Importing templates adds  
templates to the PROJECT  
complete library that were  
designed on another computer

Click file, Templates, and select 
Import template

Select previous exported  
template and open to view from 
new location
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Setting up a printer
Note: Make sure you have the printer  
driver installed before completing this  
step

Click file, Printer configurations, 
then click New and select printer.

Then click the drop-down box 
and select the printer
Your printer is now set up as an 
output device to print

Setting print alignment  
and speed

Click File, Printer configurations, 
choose the printer, then in Printer 
calibration, choose the material 
needed to be aligned.

Double-click under the offset X 
or Y, depending on how the  
alignment needs to be adjusted, 
and click up or down arrows to 
make adjustments.
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Cutter options
In the Printer configuration area, 
click Print calibration, choose 
the material, then double-click 
below the Perforation mode and 
select the type of cut or perfora-
tion needed

You are now familiar with some of the most common functions of the PROJECT complete 
marking software to create standard marking files and send them to a printer.

Any questions?  
Please call our Technical Support at 800-322-3225 and ask for a printer specialist.

Thank you! 
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You can find your local partner at 

phoenixcontact.com

Open communication with customers and 
partners worldwide
Phoenix Contact is a global market leader based in Germany. We are known 
for producing forward-thinking products and solutions for the comprehensive 
electrification, networking, and automation of all sectors of the economy and 
infrastructure. With a global network, we maintain close relationships with our 
customers, something we believe is essential for our common success.
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